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Abstract: In the paper distributed parameter 
system models in the form of lumped-
input/distributed-output systems are introduced 
and modeling of temperature fields of the die in 
the benchmark casting plant is presented. 
Temperature fields were modeled and studied 
using a finite element method based software 
package COMSOL Multiphysics and numerical 
models in the form of a lumped-input/ 
distributed-output system were obtained. These 
models serve for distributed parameter control 
synthesis purpose. Analysis of models and 
design of control loops for control of temperature 
field of the die is performed in Distributed 
Parameter Systems Blockset for MATLAB & 
Simulink - Third-party software product of The 
MathWorks. 
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1. Introduction 
 

A lot of dynamical systems analyzed in 
engineering practice, including the casting 
process, are distributed parameter systems (DPS) 
defined on complex-shape 3D definition 
domains. In order to obtain the desired structure 
during solidification, the process requires a 
specific temperature field of the die. Modeling, 
simulation and evaluation of real-time 
experiments in this area is now widely accepted 
as an important tool in product design and 
process development to improve productivity 
and casting quality.  

For analysis and control synthesis purposes, 
a benchmark of the casting processes with steel 
die of complex-shape with embedded electric 
heating elements, water-cooled copper chills and 
thermocouples was designed. It has to be able to 
embrace of typical effects and critical moments 
of casting process. 

Temperature fields of the die for casting 
processes in this benchmark were also modelled 

and studied using COMSOL Multiphysics, 
which is a finite elements method (FEM) based 
software product package. For control synthesis 
purpose, numerical models in the form of a 
lumped-input/distributed-output system (LDS) 
were created by means of numerical dynamical - 
finite element analysis.  

Analysis of models, simulation of 
temperature fields, but also design of control 
synthesis was carried out using the Distributed 
Parameter Systems Blockset for MATLAB & 
Simulink - Third-party software product of The 
MathWorks, developed at the Institute of 
Automation, Measurement and Applied 
Informatics, Faculty of Mechanical Engineering, 
Slovak University of Technology [8]. 
  
2. LDS representation of DPS 
 

Generally, DPS are systems whose 
state/output variables, X(x,y,z,t)/Y(x,y,z,t) are 
distributed variables or fields of variables, where  
(x,y,z) are spatial coordinates in 3D. In the 
mathematical theory, dynamics of DPS is 
described by partial differential equations (PDE), 
[1], [2], [3]. As to the input/output relations, 
PDE define distributed-input/distributed-output 
systems (DDS) between distributed input, 
U(x,y,z,t) and distributed output variables, 
Y(x,y,z,t), at initial and boundary conditions 
given. Distributed parameter systems very 
frequently are found in various technical and 
non-technical branches in the form of LDS, [5], 
[6], see Fig. 1.   

 
 

Figure 1. Lumped-input/distributed-output system 
representation of distributed parameter systems.   
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2.1 Dynamics of LDS  
 

Output of the linear LDS in time domain, or 
in s-domain is in the form:  
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where ( ), ,x x y z=  is position vector in 3D, 

( )iU t - lumped input quantity, ( ),i x tG - i-th 

distributed impulse response, ⊗ - denotes 

convolution product, ( ),iY x t - system response 

to the i-th input, ( ),iS x s - i-th transfer function, 

[6]. When  ( )iU t  is a unit-step (Heaviside) 

function, ( ),iY x t  is in the form of distributed 

transient response function ( ),i x tH .  

For a discrete-time system considering zero-
order hold (ZOH) units, the overall distributed 
output variable of LDS and ZOH can be 
expressed in the form: 
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where ⊕ denotes convolution sum. For points 

( ), ,i i i ix x y z=  located in surroundings of 

lumped input variables, ( )iU t , where partial 

distributed transient responses ( ),i ix tH  attain 

maximal amplitudes, partial particular distributed 
output variables are obtained in time-domain, or 
in z-domain respectively:  
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For the space dependency and in steady-state 

we can define reduced transient step responses 
between i-th input variable at point 

( ), ,i i i ix x y z=  and corresponding partial 

partcular distributed output variable in steady-
state:  
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Dynamics of LDS is decomposed to time and 
space components. In the time dependency, there 
are, discrete transfer functions of the form 

( ){ }
1,

,i i i n
SH x z

=
and in the space direction there 

are ( ){ }
1,

,i i n
HR x

=
∞H . 

 
2.2 Feedback control loop based on LDS  

 
Structure of DPS feedback control loop 

based on LDS is on Fig. 2, where the goal of 
control is to ensure the steady-state control error 
to be minimal: 

( ) ( ) ( )min , min , ,E x W x Y x∞ = ∞ − ∞        (7) 

 
 
Figure 2. Distributed parameter feedback control 
loop: HLDS - LDS with zero-order holds {Hi} i on the 
input, CS - control synthesis, TS - control synthesis in 
time domain, SS - control synthesis in space domain,  

( ),Y x t  - distributed controlled variable,  ( ),W x k  - 

control variable, ( ),V x t  - disturbance variable,  

( ),E x k  - control error,  K - time/space sampling. 

 
In the block SS, approximation of distributed 

control error ( ),E x k , on the set of reduced 

steady-state distributed step responses 

( ){ },i i
HR x ∞H , is solved. 
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As the solution of approximation problem, 

the control errors vector ( ) ( ){ }i i
E k E k=
⌣

⌣

 enters 

into the block TS, where vector of control 
variables, ( )U k , is generated by controllers, 

( ){ }i i
R z  in single-parameter control loops.  



3. Benchmark casting plant 
 

For study of the phenomena occurring during 
casting solidification, from a control point of 
view, control system development as well as 
mathematical model validation, a benchmark of 
the casting processes was designed, see Fig. 3.  

The core item is the two-part steel die 
(mould) of a complex-shape mounted in the 
frame of the ejector mechanism. Inside of the 
casting die are built-in electric heating elements, 
water-cooled copper chills and thermocouples, 
see Fig. 4. Location of these elements has been 
carefully designed in order to have the 
possibility of preheating the die in 5 zones 
achieving desired temperature profile as well as 
directional solidification of the casting by means 
of active heat removal. The main heating circuit 
is divided into five independent circuits. 
Hydraulic cooling circuit consists of an array of 
induction motor driven roller vane pumps, a 
bunch of hoses, a flow divider, a collector with 
built-in check valves, a plate heat exchanger and 
an expansion tank. 

 
 

Figure 3. Scheme of the benchmark casting plant.  

 
 

Figure 4. Bottom side of the steel casting die. 

4. Modeling of temperature fields of 
casting die in COMSOL Multiphysics  
 

The casting die is one of the key components 
of a casting. It is well known, that the quality of 
castings is affected strongly by the surface 
quality and the distribution of temperature in the 
die. Temperature field of the die in the casting 
process is a typical case of DPS. For modeling of 
temperature fields as DPS based on FEM, wide 
possibilities are offered by COMSOL 
Multiphysics Environment with Heat Transfer 
Module. 

Distribution of temperatures in the casting 
die over the definition domain 3EΩ ∈  is 
modelled by PDE of parabolic type with specific 
initial and boundary conditions: 
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wherea cλ ρ= is temperature conductivity 
(m2.s-1).  

3D geometry model of the die was drawn in 
a CAD environment and imported into 
COMSOL Multiphysics, where all parameters of 
PDE and other necessary conditions for 
simulation and data processing were specified 
through graphical user interface (GUI), Fig. 5.  

There by means of the toolbar menu in the 
Physics menu subdomains of the die with their 
parameters were defined. Parameters like 
thermal conductivity, density, heat capacity and 
heat source either for Iron or Copper were loaded 
from Library material. Heating elements in the 
cylinder shape, where heat sources as actuating 
quantities were defined,  were grouped into 5 
subdomains of the die, each contains 4 – 6 
elements, see Fig. 6. Similarly were defined as 
groups copper chills, see Fig. 7, next bottom and 
upper part of the die. Also in the Physics menu 
Boundary conditions were defined.  

In the Mesh menu mesh for the given 
geometry was analysed, e.g. initial mesh, various 
predefined mesh sizes, etc. The Mesh Statistics 
dialog box, available from the Mesh menu, 
contains statistical data for the current mesh.  

In the Solve menu temperature fields of the 
die either in stationary, or transient form were 
computed by FEM, see Fig. 8, Fig. 9. Actuating 
of heating elements was performed separately in 
each zone. 



Obtained temperature fields were analyzed 
by means of various forms of plots and their 
parameters, including AVI animation with help 
of the Postprocessing menu. 

Finally, in the File menu Postprocessing data 
in the form of nodes, elements, data were 
exported either as txt or m-files.  

 

 
 
Figure 5. 3D geometry model of the casting die. 
 

 
 
Figure 6. Location of heating elements in the die. 
 

 
 
Figure 7. Location of copper chills in the die. 

 

 

 

 

 
 
Figure 8. Temperature fields in steady-state actuated 
by heating elements in Zone #1 – Zone #5. 
 

 

 
 
Figure 9. Temperature fields in transient form in 
given times, actuated by heating elements in Zone #5.  



5. DPS Blockset for MATLAB & 
Simulink 
 

For a software support of modeling, control 
and design of Distributed Parameter Systems 
given on complex 3D domains of definition, 
DPS Blockset for MATLAB & Simulink as 
Third-Party MathWorks Product has been 
developed [8], see Fig. 10. The library of DPS 
Blockset shows Fig. 11. 

The block HLDS models controlled 
distributed parameter systems as lumped-
input/distributed-output systems with zero-order 
hold units. The DPS Control Synthesis provides 
feedback to distributed parameter controlled 
systems in control loops with blocks for PID, 
algebraic, state space and robust control. The 
block DPS Input generates distributed quantities 
which can be used as distributed control 
variables or distributed disturbances, etc. DPS 
Display presents distributed quantities with 
many options including export to AVI files. The 
block DPS Space Synthesis performs space 
synthesis as an approximation problem. The 
block Tutorial presents methodological 
framework for formulation and solution of 
distributed parameter systems of control. The 
block Show contains motivation examples. The 
block Demos contains examples oriented to 
methodology of modeling and control synthesis. 
The DPS Wizard in step-by-step operation, by 
means of five model examples on 1D-3D with 
default parameters, gives a guide for 
arrangement and setting distributed parameter 
control loops.  
 

 
 
Figure 10. DPS Blockset on the web portal of The 
MathWorks. 
 

 
 
Figure 11. The library of DPS Blockset for MATLAB 
& Simulink. 
 
6. Simulation of preheating of casting die  
 

Temperature fields of the mould obtained by 
FEM solution in COMSOL Multiphysics were 
exported to Matlab-Simulink, in order to 
determine lumped and distributed models. 
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Transfer functions were identified in GUI 
ident of the System Identification Toolbox for 
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temperatures attain maximal values, e.g. for 
actuating in Zone #5 result of identification is on 
Fig. 12 and obtained continuous and discrete 
transfer functions are in the form: 
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Simulation of the control process with five 

PID controllers was realised in the DPS Blockset 
for MATLAB & Simulink. By means of blocks 
of the DPS Blockset, DPS feedback control 
system with five PID controllers embedded in 
the DPS PID Synthesis block was arranged, see 
Fig. 13. Synthesis of PID controllers was 
adjusted in order to assure aperiodic running of 
the quadratic norm of distributed control error. 
Results of the PID control process for given 
reference quantity are on Fig. 14.  

 
 
Figure 12. Identification of partial transient response 
in Zone #5. 
 

 
 
Figure 13. PID feedback control loop in DPS 
Blockset. 
 
 
 
 
 

 

 

 

 
 
Figure 14. PID control of temperature field of the 
casting die: distributed reference quantity ( ),W x ∞ , 

quantity ( ),Y x ∞ , control variables ( )iU k  and 

quadratic norm of distributed control error ( ),E x k . 

 
 



7. Conclusions 
 

Nowadays, a number of software products, 
environments and virtual try-out spaces for 
numerical dynamical analysis of machines and 
processes are at disposal, practically in all 
engineering disciplines. Based on powerful FEM 
solvers and advanced specific options, COMSOL 
Multiphysics provides an efficient and accurate 
solution which users need. In the casting area it 
is the key solution to reduce manufacturing 
costs, shorten lead times for die developments 
and improve the casting process quality.  

Results of numerical modeling of DPS are 
useful not only for study of their dynamics, but 
also for design of various control synthesis 
methods by using of DPS Blockset. 
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